LEGISLATOR DATABASE

September, 2012

1. INTRODUCTION
2. LIST OF QUERIES
3. FIELDS
4. QUERY DESCRIPTIONS
5. USING THE LEGISLATOR DATABASE QUERIES
6. DOWNLOADING THE LEGISLATOR DATABASE FROM THE CGA HOME PAGE
7. CREATING MAILING LABELS IN MICROSOFT WORD USING THE LEGISLATOR DATABASE
8. CREATING MAILING LABELS IN MICROSOFT ACCESS USING THE LEGISLATOR DATABASE
9. USING THE EXISTING LABEL DOCUMENTS
10. NEW QUERIES
11. CREATING A NEW QUERY

***Please note that the instructions given for using this Database are specific to Microsoft Office products. For Web accessibility reasons, the word "select" means the same as the word "click" or "double-click."
1. INTRODUCTION

Often employees of the Connecticut General Assembly (CGA) need to create mailings to be sent to every Legislator or to a specific group of Legislators. To facilitate this process, Information Technology Services (ITS) has created and maintains an Access database named LegislatorDatabase.mdb.

This database contains a table (named LegislatorTable) and multiple queries and reports. To access this database, go to the CGA home page and select Session Information. The Legislator Database is under the Legislative Information Download section of the page.
2. **LIST OF QUERIES**

A *query* is a database tool used to search and display information that meets your specific criteria. The information retrieved from the query can be saved as a "QRY" object in the database.

Some of the queries in the **LegislatorDatabase** are:

<table>
<thead>
<tr>
<th>Access Query Names:</th>
<th>Access Query Names:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Committees:</td>
<td>Caucuses:</td>
</tr>
<tr>
<td>QRYAging</td>
<td>QRYDemocratRepresentatives</td>
</tr>
<tr>
<td>QRYAppropriations</td>
<td>QRYDemocratSenators</td>
</tr>
<tr>
<td>QRYBanks</td>
<td>QRYHouseDemocraticMembers</td>
</tr>
<tr>
<td>QRYChildren</td>
<td>QRYHouseRepublicanMembers</td>
</tr>
<tr>
<td>QRYCommerce</td>
<td>QRYRepublicanRepresentatives</td>
</tr>
<tr>
<td>QRYEducation</td>
<td>QRYRepublicanSenators</td>
</tr>
<tr>
<td>QRYEnergy</td>
<td>QRYSenateDemocraticMembers</td>
</tr>
<tr>
<td>QRYExNoms</td>
<td>QRYSenateRepublicanMembers</td>
</tr>
<tr>
<td>QRYFinance</td>
<td></td>
</tr>
<tr>
<td>QRYGAE</td>
<td></td>
</tr>
<tr>
<td>QRYGeneralLaw</td>
<td><strong>Legislature:</strong></td>
</tr>
<tr>
<td>QRYHigherEducation</td>
<td>QRYAlphaHouse</td>
</tr>
<tr>
<td>QRYHousing</td>
<td>QRYAlphaSenate</td>
</tr>
<tr>
<td>QRYHumanServices</td>
<td>QRYEmail</td>
</tr>
<tr>
<td>QRYInsurance</td>
<td>QRYEmailandURL</td>
</tr>
<tr>
<td>QRYInternship</td>
<td>QRYFemaleAlpha</td>
</tr>
<tr>
<td>QRYJudiciary</td>
<td>QRYFemaleAlphabyDistrict</td>
</tr>
<tr>
<td>QRYLabor</td>
<td>QRYHouse</td>
</tr>
<tr>
<td>QRYLegislativeManagement</td>
<td>QRYHouseMembersAlphabetical</td>
</tr>
<tr>
<td>QRYP&amp;D</td>
<td>QRYHouseMembersNumerical</td>
</tr>
<tr>
<td>QRYPublicReview</td>
<td>QRYLeadershipTitles</td>
</tr>
<tr>
<td>QRYPublicHealth</td>
<td>QRYLegAlphaRoom</td>
</tr>
<tr>
<td>QRYPublicSafety</td>
<td>QRYLegAlphaRoomPhone</td>
</tr>
<tr>
<td>QRYRegReview</td>
<td>QRYMale</td>
</tr>
<tr>
<td>QRYTransportation</td>
<td>QRYMalebyDistrict</td>
</tr>
<tr>
<td>QRYVeteransAffairs</td>
<td>QRYNumHouse</td>
</tr>
<tr>
<td>QRYCommitteeChairs</td>
<td>QRYNumSenate</td>
</tr>
<tr>
<td>QRYRankingMembers</td>
<td>QRYRepresentatives</td>
</tr>
<tr>
<td>QRYViceChairs</td>
<td>QRYSenate</td>
</tr>
<tr>
<td></td>
<td>QRYSenateMembersAlphabetical</td>
</tr>
<tr>
<td></td>
<td>QRYSenateMembersNumerical</td>
</tr>
<tr>
<td></td>
<td>QRYPrison</td>
</tr>
</tbody>
</table>
3. FIELDS

Each of the queries contains some of the following fields of information. An example or description of the text in each field is included after the name of each field.

- **dist** (e.g., 002 for district number)
- **office code** (e.g., S for Senate or H for House)
- **district number** (e.g., 2nd)
- **designator code** (e.g., N for Newly Elected, R for Reelected, F for Former)
- **first name** (e.g., Eric)
- **middle initial** (e.g., D.)
- **last name** (e.g., Coleman)
- **suffix** (e.g., Jr., Sr., II, etc.)
- **commonly used name** (e.g., Eric)
- **home street address** (e.g., 77 Wintonberry Avenue)
- **home city** (e.g., Bloomfield)
- **home state** (e.g., CT)
- **home zip code** (e.g., 06002)
- **home phone** (e.g., 860-527-9682)
- **capitol street address** (e.g., Legislative Office Building)
- **capitol city** (e.g., Hartford, CT 06106-1591)
- **capitol phone** (e.g., 860-240-0366)
- **room** (This field contains only the word, Room.)
- **room number** (e.g., 2500)
- **committees chaired** (e.g., Judiciary, etc.)
- **committees vice chaired** (e.g., Human Services, etc.)
- **ranking member** (e.g., Public Safety, etc.)
- **committee memberships** (e.g., Judiciary (Chair); Human Services (Vice Chair); Program Review and Investigations, etc.)
- **senator/representative** (e.g., Senator or Representative)
- **party** (e.g., Democrat or Republican)
- **leadership title** (e.g., Deputy President Pro Tempore)
- **gender** (e.g., male or female)
- **business phone** (This field may contain a business phone number.)
- **email** (This field contains the Legislator's e-mail address.)
- **fax** (This field may contain a fax number.)
- **prison** (This field indicates a prison is located in the Legislator's district.)
- **URL** (This field contains the Legislator's Website address.)
- **committee codes** (This field contains the committee membership codes.)

The LegislatorTable contains all of these fields for use in creating new queries.
4. QUERY DESCRIPTIONS

The following are descriptions of the information retrieved from some of the queries. To view the results of a query, select the QRY name.

Queries for Committees

You can select queries for each committee to display the Members for that Committee.

Select this query: QRYAppropriations
To display the records for: Appropriations Committee Members

You can select queries for the Committee Chairs, and Vice Chairs, and Ranking Members.

Select this query: QRYCommitteeChairs
To display the records for: Committee Chairs

Select this query: QRYViceChairs
To display the records for: Committee Vice Chairs

Select this query: QRYRankingMembers
To display the records for: Ranking Members

Queries for Caucus

You can select queries for the House and Senate to display the Members by Party.

Select this query: QRYHouseDemocraticMembers
To display the records for: Democratic Representatives

Select this query: QRYHouseRepublicanMembers
To display the records for: Republican Representatives

Select this query: QRYSenateDemocraticMembers
To display the records for: Democratic Senators

Select this query: QRYSenateRepublicanMembers
To display the records for: Republican Senators
Queries for Legislature

You can select the queries for either or both Chambers.

Select this query: **QRYAlphaHouse**
To display the records for: Representatives sorted alphabetically by Last Name

Select this query: **QRYAlphaSenate**
To display the records for: Senators sorted alphabetically by Last Name

Select this query: **QRYEmail**
To display the records for: Legislators with E-mail Address

Select this query: **QRYEmailandURL**
To display the records for: Legislators with E-mail Address and Web Address

Select this query: **QRYLegAlphaRoomPhone**
To display the records for: Legislators and Capitol/Legislative Office Building Room Number, Phone

Select this query: **QRYLeadershipTitles**
To display the records for: Legislators with Leadership Titles

Select this query: **QRYNumHouse**
To display the records for: Representatives sorted by District

Select this query: **QRYNumSenate**
To display the records for: Senators sorted by District

Select this query: **QRYPrison**
To display the records for: Legislators with a Prison in District

**NOTE:** The query names begin with the letters "QRY." The "QRY" is an abbreviation for the word "Query" and means that specific information has been retrieved from the LegislatorTable and saved to a new object, or query.
5. USING THE LEGISLATOR DATABASE QUERIES

Microsoft Access queries are commonly used as a "Data Source" in a Microsoft Word Mail Merge to create labels, envelopes, and letters. For example, if you need to create a set of labels containing Capitol/Legislative Office Building addresses for all Senators or for all Representatives, you would select QRYSenate or QRYHouse as the "Data Source" from which the desired fields would be inserted into your Main Document in the Microsoft Word Mail Merge process.

Sections 7 and 8 contain step-by-step instructions to create mailing labels using Microsoft Word or Microsoft Access.
6. DOWNLOADING THE LEGISLATOR DATABASE FROM THE CGA HOME PAGE

The Legislative Information Download option is accessed from the Session Information link on the CGA home page. This database file is updated as changes occur. If this database is updated after you download it, you will need to download the file again.

To download the Legislator Database:

- Go to the CGA home page, select Session Information, and select Legislator Database - MS Access 2000.

A message box displays.

- Select Save as. The "Save As" window displays on your screen. Save the file to the desired location. A message box displays when the download is complete.

- Close the message box.

The LegislatorDatabase.mdb file is now usable as a "Data Source" in a Microsoft Word Mail Merge.
7. CREATING MAILING LABELS IN MICROSOFT WORD USING THE LEGISLATOR DATABASE

The following example provides step-by-step instructions to create mailing labels in Microsoft Word with Capitol/Legislative Office Building addresses for all Senators using QRYSenators as the Data Source.

Step 1: Create the Main Document

- Open Microsoft Word and open up a new blank document.
- Select the Mailings tab.
- Select Start Mail Merge and select Labels...

- In the Label Options dialog box, select the correct printer tray, the type of labels (i.e., Avery standard 5261 – Address) and select OK.

If the type of labels that you want to use is not listed in the Product number list, you may want to create your own custom labels.
Step 2: Open an Existing Data Source

- Choose Select Recipients and select Use existing list...

- In the Select Data Source dialog box, navigate to the location of the downloaded Legislator Database, select the downloaded file, LegislatorDatabase.mdb, and select Open. (Note: You can use a Word document, a worksheet, or other list as a Data Source.)

  The Select Table dialog box displays.

Step 3: Select the Query with the Data for the Labels

- Scroll through the list of Queries, select QRYSenate and select OK.
Step 4: Insert Merge Fields

**NOTE:** The default paragraph spacing for Mail Merge labels is set to 5.56 pt. before a paragraph. If you wish to minimize the spacing, select the Page Layout tab, and set the Spacing Before in the Paragraph group to 0 pt.

- Select **Insert Merge Field** to display the list of fields.

  (This list may vary depending upon whether you opened a Query or the LegislatorTable.)

To create this label, for example…

Senator Eric Coleman  
Room 2500, Legislative Office Building  
Hartford, CT 06106-1591

follow these steps:

- Select `<senatorrepresentative>` from the list. This field is inserted on the first label. Type a space after this field.

- Select **Insert Merge Field**. Select `<first_name>` from the list. This field is inserted on the first label. Type a space after this field.

- Select **Insert Merge Field**. Select `<last_name>` from the list. This field is inserted on the first label. Type a return after this field.
• Select **Insert Merge Field**. Select `<room>` from the list. This field is inserted on the first label. Type a space after this field.

• Select **Insert Merge Field**. Select `<room_number>` from the list. This field is inserted on the first label. Type a comma and a space after this field.

• Select **Insert Merge Field**. Select `<capitol_street_address>` from the list. This field is inserted on the first label. Type a return after this field.

• Select **Insert Merge Field**. Select `<capitol_city>` from the list. This field is inserted on the first label.

Your first label is now complete.
Step 5: Update Labels

- To copy the format and layout of the first label to all the other labels on the page, select **Update Labels**.

The format and layout of the sample label is copied to all of the labels on the page.
Step 6: Preview the Labels

- Select **Preview Results** to preview the data on the labels.

To sort the labels in a different order, select **Edit Recipient list**. Select the **Sort...** option in the **Mail Merge Recipients** dialog box and choose the desired option. Select **OK** when done.
The labels are updated to display the changes.

- Select **Preview Results** to turn off the preview.

To check the Data Source for errors before you merge, select **Auto Check for Errors**, choose an option, and then select **OK**.

**Step 7: Merge the Data into the Main Document**

- Select **Finish & Merge** button on the **Mailings** tab.

- Select one of the following options:
  
  o Select **Edit Individual Documents**... to create the merged labels in a new document, so you can review, edit, and print them later. *This is the recommended option.*
  
  ![Edit Individual Documents](image)

  o Select **Print Documents**... to send the merged labels to a printer.

  ![Print Documents](image)
• Select All to create or print labels for all Senators and select OK. When the merge is completed, the labels are created in a new document or sent to the printer.

• You are now ready to print the labels. Load the proper label sheets into the printer tray. Select the File tab, select Print, selected the desired printer and options and select Print.
NOTE: MERGE NOT AS EXPECTED? Before printing, scroll through the newly merged document to be sure everything appears correctly and as expected. If the merge is not correct, close the merged document by selecting the X in the upper right corner of the window. You will be asked if you want to save the changes. Select No. You will now be back to the "Mail Merge" environment and will be able to make changes and merge the documents again.
8. CREATING MAILING LABELS IN MICROSOFT ACCESS USING THE LEGISLATOR DATABASE

The following example provides step-by-step instructions to create mailing labels in Microsoft Access with Capitol/Legislative Office Building addresses for all Senators using QRYSenate as the Data Source.

- Open the LegislatorDatabase.mdb file.
- Select QRYSenate under Queries in the Navigation pane.
- On the Create tab in the Reports group, select Labels.

- The Label Wizard displays.
• Select **Avery** from the drop-down list for the **Filter by manufacturer** field. Select **English** for the Unit of Measure, and scroll through the **Product number** list and select **5261**.

• Select **Next>** to continue.

![Label Wizard](image)

• Make text appearance changes if desired and select **Next>** to continue.

• On the **What would you like on your mailing label** section of the wizard, select the fields you would like on the labels from the **Available fields** list and select the right arrow or double-click them. The fields are added to the **Prototype label**. **Note**: Be sure to add spaces and returns between the fields where necessary.

![Label Wizard](image)

• Select **Next>** to continue.
• To select one or more fields for sorting the labels, select the fields from the **Available fields** list and select the right arrow or double-click them. The fields are moved to the **Sort by:** column.

• Select **Next>** to continue.

• Change the name of the label report if desired, or just select **Finish**.
**Note:** The following message may display depending upon the measurements of some labels. It occurs when the labels come very close to the left and right edges of the label sheet. This can cause the wizard to display this message when you preview or print your labels.

If you are satisfied with the alignment of the text on the labels and you are not getting a blank page every other page, you can select OK when this message appears.

The completed label report displays in a separate window.

- You are now ready to print the labels. Load the proper label sheets into the printer tray. Select the **File** tab, select **Print**, selected the desired printer and options and select **Print**.

***

**NOTE: LABELS NOT AS EXPECTED?** If the resulting label report doesn't look the way you want, you can delete the report and run the Label Wizard again.
9. USING THE EXISTING LABEL REPORTS

For your convenience, the following label reports have been created and saved under Reports in the Legislator Database. These reports are formatted to print on Avery 5261 labels.

- **LabelsAllLegAlphaHome**
  
  Labels for all Legislators with the Home Address sorted alphabetically by Last Name

- **LabelsAllLegAlphaLOB**
  
  Labels for all Legislators with the Capitol/Legislative Office Building Address sorted alphabetically by Last Name

To access these labels, open the Legislator Database.mdb file. In the Database window, select the Reports object in the Navigation Pane.

To view the labels, right-click the desired label report and select Print Preview from the shortcut menu. To close the preview, select the Close Print Preview button.

To print the labels, load the proper label sheets into the printer tray. Right-click the desired label report and select Print from the shortcut menu.
10. NEW QUERIES

A Microsoft Access Query searches for specific information from the LegislatorTable and creates a new query based on the search criteria. For example, if you want to create a form letter to all Female Senators, and there is not an existing query that retrieves this information, you will need to create your own query to retrieve this specific information.

Step-by-step instructions for performing a new query follow in Section 11.
11. CREATING A NEW QUERY

To search and retrieve a listing of all Female Senators with their addresses, you will need to create a new Microsoft Access Query.

- Open Microsoft Access. Open the **LegislatorDatabase.mdb** file.
- Select the Create tab, and select **Query Design** in the Queries group.
- In the Show Table dialog box, select the **LegislatorTable**, and select **Add**. Select Close to close the dialog box.
A field list from the LegisladorTable displays in the upper portion of the query screen.

Your screen displays as follows. This is referred to as the "Design View."

The process of creating a query begins with selecting the fields that contain the data that you want to query. These fields must be selected into the QBE (Query by Example) grid at the bottom of the screen.

To select fields for the query, scroll through the field list in the upper part of the screen to locate the desired field. Double-click the desired field name. The field name will display in the first column of the field row in the Query grid. Repeat this process until all desired fields appear in the Query grid. **Note:** You can also drag fields from the table to an empty column in the grid.
For example, in order to create a query to retrieve all Female Senators sorted alphabetically by their last name with the home address, the following fields would be required:

- senator/representative
- first name
- last name
- home street address
- home city
- home state
- home zip code
- gender

After selecting all of these fields for the query, the screen will appear similar to the following.

![Query Screen]

**Sort Alphabetically by Last Name**

- To sort the Legislators alphabetically by "last name," position the cursor in the Sort row under the "last name" field. You will see a drop-down arrow display. Select the drop-down arrow and select **Ascending**.
Select Female Senators

- To select only Senators, position the cursor in the Criteria row under the "senator/representative" field. Type Senator.

- To select only Females, position the cursor in the Criteria row under the "gender" field. Type Female.

After specifying all of the criteria, your screen displays as follows.
Run the Query

- Select Run on the Design tab in the Results group to run the query. The resulting query displays all Female Senators sorted alphabetically by Last Name.

The query displays in a datasheet view.

NOTE: When you are working in the “Design View,” you will see the row entitled “Show.” The row contains a box with a checkmark for each field. If a box contains a checkmark, the information in that field will display in the resulting query. If you do not want the information in that field to display in the resulting query, select the check box to remove the checkmark. No checkmark indicates that the information in that row will be hidden in the resulting query.
**Modify the Query**

- If you wish to take this query a step further and modify it to retrieve only the **Female Democrat Senators**, switch back to Design View while you are still in the resulting query. Select **View** on the **Home** tab and select **Design View**.

- You will need to add the field "party" to the Query grid. Select **party** from the field list to add it to the Query Grid.

- Position the cursor in the Criteria row under the "party" field. Type **Democrat**.
Your screen displays as follows.

- Select **Run** on the **Design** tab in the **Results** group to run the query. The resulting query displays all Female Democrat Senators sorted alphabetically by Last Name.

To **print** the results of the query, select the **File** tab, select **Print**, selected the desired printer and options and select **Print**.

To **save** the query within the current database, press **CTRL+S** to save the query. In the **Save As** dialog box, type the name of the query (i.e., **QRYFemaleDemocratSenators**) and select **OK**.

The query can now be used as a "Data Source" in a Microsoft Word Mail Merge.